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Encrypted Emails in Office365

Updated 07/21/25.

About

Office365 Message Encryption (OME) is a feature that allows you to send
encrypted emails to any recipient, using Outlook desktop app or Outlook Online
at https://outlook.office.com. Recipients can view encrypted emails through a
web browser, using a one-time passcode or signing in with a Microsoft account.
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https://outlook.office.com/

Send Encrypted Email in Outlook Desktop App

To access the encrypted email options in Outlook desktop app:

Step 1 — Open Outlook and compose a new email

Open the Outlook desktop app and compose a new email (including the

recipient, subject, body, etc).
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Step 2 — Select Encryption Options (Options tab > Encrypt)

1. Select the Options tab.
2. Select Encrypt.

o ) [£ v = TestEncrypted Email - Message (HTML)

File Message 1 Options f| Format Text  Review Help Acrobat

) O : .
Aa |': Bq 2 IJ;LI é. Request a Delivery Receipt t24 Delay Delive

E0 From . N .
| Encrypt|| Use Voting Request a Read Receipt Save Sent ‘<, Direct Replig
i Buttons v Item To v

Show F 3 Set permission on this item
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3. Under “Set Permission on this item,” select from the following:
A. Encrypt-Only: This message is encrypted. Recipients cannot remove
encryption.

Encrypt-Only - This message is encrypted. Recipients can't remove encryption.
Permission granted by: @rsccd.edu

B. Do Not Forward: Recipients can read this message, but cannot forward,
print, or copy content. The conversation owner has full permission to
their message and all replies.

Do Mot Forward - Recipients can read this message, but cannot forward, print, or copy

content. The conversation owner has full permission to their message and all replies.
Permission granted by: @rsccd.edu

Once you have selected the encryption type, a note will appear on the email that
will state it is encrypted (as shown in 3a and 3b).




Step 3 — Send the Email

Send the email with your selected encryption option.

File Message |Insert Options FormatText Review Help

}\Q/ E—l t23 Delay Delivery

Encrypt| Tracking Save Sent 2 Direct Replies
M v b Item To v

Show Fields | Encrypt More Options

Encrypt-Only - This message is encrypted. Recipients can't remove encryption.
Permission granted by: I ~ © 77 Drsced.edu
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Step 4, Option A — Recipient opens/replies to Encrypted Email in Outlook

If your recipient is also using Outlook with a Microsoft account, they will see a
lock icon on your email indicating it is a secure/encrypted email.

Test Email 940 AM

Outlook will automatically verify the recipient in the background, and the
person can just open the email like a normal message.

Test Email
HR To

Encrypt-Only - This message is encrypted. ients can't remove encryption.
Permission granted by: [ du

Hello....

If the recipient replies to an encrypted email from Outlook, it will look and
behave the same as a normal email reply, with added disclaimers in the header
and bottom of the email about how the email is encrypted and has restrictions.
o HYO [~ = RE: TestEmail - Mes.. je
Encrypt-Only - This messa

Permission granted by: H

} From v @rsccd.edu

Send

RE: Test Email

Test reply

Sincerely,
John

Note: This conversation is restricted, so you might not be able to cut or copy from it. See
the information above the To line for more details. Also, while the conversation is
restricted, the conversation owner can send the message to other people.




Step 4, Option B — Recipient opens/replies to Encrypted Email in non-

Outlook client

For non-Outlook users, the encrypted message will appear differently.

The body of the message for non-Outlook users will show the following:
[Email Address] has sent you a protected message.

Read the Message

Test Email to Gmail Inbox x

@rsccd.edu>

tome =

rsccd.edu) has sent you a protected
message.

a

Read the message

Learn about messages protected by Microsoft Purview Message
Encryption.

Privacy Statement

Learn More on email encryption.
Microsoft Corporation, One Microsoft Way, Redmond, WA 98052

When the recipient selects “Read the message,” they will be sent to Outlook
Online website to verify their account.




Verifying identity of Non-Outlook users

A. The user can Sign in with their account (such as Gmail, Yahoo ID,
Microsoft, etc).
B. Or they can Sign with a One-time passcode

o~ Encrypted Message Authenticas * +

C °5 outlook.office365.com/Encryption/authentic... ¥¢

Encrypted Message

(@rsccd.edu has sent you a protected message

Lo lock

Sign in to view the message

o Sign in with Google
©

Need Help?

Privacy Statement




If using a One-time passcode, the recipient will be sent a separate email with
subject line Your one-time passcode to view the message.

Your one-time passcode to view the message & ©&

Inbox x

Microsoft Office 365 Message En.. 222PM (O minutesago) vy (2 &
tome =

Here is your one-time passcode

89184293

To view your message, enter the code in the web page where you requested
it.

NOTE: This one-time passcode expires 15 minutes after it was requested.

The recipient can use this one-time passcode when prompted:

“ Encrypted Message OTP Signin X ar

Cc 25 outlook.office365.com/Encryption/OTPSigninPage.aspx?itemID...

| Help

We sent a one-time passcode to @gmail.com.

Please check your email, enter the one-time passcode and click continue. The one-time
passcode will expire in 15 minutes.

One-time passcode (89184293 Ih

O This is a private computer. Keep me signed in for 12 hours.

Continue

Didn't receive the one-time passcode? Check your spam folder or get another one-time passcode.

[s lock Message Encryption by Microsoft Office 365




Once the non-Outlook user verifies their identity, they will be taken to an
encrypted version of the Outlook Web App, where they can view the message and
send replies.

d o« Encrypted Message x ar

< & 23 outlook.office365.com/Encryption/default.aspx

| Sian Out || [ "Help

Test Email to Gmail

@ ’ - @rsccd.edu>  © Replyall | v
Today, 2:08 PM

@gmail.com> ¥

Encrypt: This message is encrypted. Recipients can't remove encryption.

Test Email to Gmail

7 o Encrypted Message X ar
< c 25 outlook.office365.com/Encryption/default.aspx

Sian Out || [ "Help

= Send [ Attach  Discard  see

Encrypt: This message is encrypted. Recipients can't remove encryption.

To @ @rsccd.edu> X Bce

Cc @ N.F. X

Re: Test Email to Gmail a

Reply to test email
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Send Encrypted Email in Outlook Online

To send encrypted emails with Outlook Online at https://outlook.office.com:

Step 1 — Login to Outlook Online Compose a new email

Login to https://outlook.office.com.

Select “New mail” to compose a new email (including the recipient, subject, body,
etc).

O @ &= office.com

Message Insert Format text Draw Options

Aptos 11 B v

From: @rsced.edu -~

To @gmail.com> X |

Cc
Bcc

Test Encrypted Email

Test Encrypted Email

Regards,
Nick]



https://outlook.office.com/
https://outlook.office.com/

Step 2 — Select Encryption Options (Options tab > Encrypt)

1. Select the Options tab.
2. Select the Lock Icon (for Encrypt).
a. If needed, expand the window to see the Lock icon.

) Test Encrypted Email — Moxzilla Firefox
O @ & office.com

Message Insert Format text Dral 1 Options

v o Show Bcc Show Cc Show From B O

Do Not Forward: Recipients can't forward, print, or copy content. 3 Set permissions on this item
From: rsccd.edu + Encrypt A
gmail.com> x | Do Not Forward B

No permission set

3. Under “Set Permission on this item,” select from the following:
a. Encrypt-Only: This message is encrypted. Recipients cannot remove
encryption.

Encrypt: This message is encrypted. Recipients can't remove encryption.

b. Do Not Forward: Recipients cannot forward, print, or copy content.

Do Mot Forward: Recipients can't forward, print, or copy content.

Once you have selected the encryption type, a note will appear on the email that
will state it is encrypted (as shown in 3a and 3b).




Step 3 —Send the email

Send the email with your selected encryption option.

) Test Encrypted Email — Mozilla Firefox

O @® &= office.com

Message Insert Format text Draw Options

re Show Bcc Show Cc

Do Mot Forward: Recipients can't forward, print, or copy content.
From: rsccd.edu -~

gmail.com> X |




Step 4, Option A — Recipient opens/replies to Encrypted Email in Outlook

If your recipient is also using Outlook with a Microsoft account, they will see a
lock icon on your email indicating it is a secure/encrypted email.

Test Email 940 AM

Outlook will automatically verify the recipient in the background, and the
person can just open the email like a normal message.

Test Email

HR

To

Encrypt-Only - This message is encrypted. ients can't remove encryption.
Permission granted by: [ du

Hello....

If the recipient replies to an encrypted email from Outlook, it will look and
behave the same as a normal email reply, with added disclaimers in the header
and bottom of the email about how the email is encrypted and has restrictions.
o HYO [~ = RE: TestEmail - Mes.. je
Encrypt-Only - This messa

Permission granted by: H

} From v @rsccd.edu

Send

RE: Test Email

Test reply

Sincerely,
John

Note: This conversation is restricted, so you might not be able to cut or copy from it. See
the information above the To line for more details. Also, while the conversation is
restricted, the conversation owner can send the message to other people.




Step 4, Option B — Recipient opens/replies to Encrypted Email in non-

Outlook client

For non-Outlook users, the encrypted message will appear differently.

The body of the message for non-Outlook users will show the following:
[Email Address] has sent you a protected message.

Read the Message

Test Email to Gmail Inbox x

@rsccd.edu>

tome =

rsccd.edu) has sent you a protected
message.

a

Read the message

Learn about messages protected by Microsoft Purview Message
Encryption.

Privacy Statement

Learn More on email encryption.
Microsoft Corporation, One Microsoft Way, Redmond, WA 98052

When the recipient selects “Read the message,” they will be sent to Outlook
Online website to verify their account.




Verifying identity of Non-Outlook users

A. The user can Sign in with their account (such as Gmail, Yahoo ID,
Microsoft, etc).
B. Or they can Sign with a One-time passcode

o~ Encrypted Message Authenticas * +

C °5 outlook.office365.com/Encryption/authentic... ¥¢

Encrypted Message

(@rsccd.edu has sent you a protected message

Lo lock

Sign in to view the message

o Sign in with Google
©

Need Help?

Privacy Statement




If using a One-time passcode, the recipient will be sent a separate email with
subject line Your one-time passcode to view the message.

Your one-time passcode to view the message & ©&

Inbox x

Microsoft Office 365 Message En.. 222PM (O minutesago) vy (2 &
tome =

Here is your one-time passcode

89184293

To view your message, enter the code in the web page where you requested
it.

NOTE: This one-time passcode expires 15 minutes after it was requested.

The recipient can use this one-time passcode when prompted:

“ Encrypted Message OTP Signin X ar

Cc 25 outlook.office365.com/Encryption/OTPSigninPage.aspx?itemID...

| Help

We sent a one-time passcode to @gmail.com.

Please check your email, enter the one-time passcode and click continue. The one-time
passcode will expire in 15 minutes.

One-time passcode (89184293 Ih

O This is a private computer. Keep me signed in for 12 hours.

Continue

Didn't receive the one-time passcode? Check your spam folder or get another one-time passcode.

[s lock Message Encryption by Microsoft Office 365




Once the non-Outlook user verifies their identity, they will be taken to an
encrypted version of the Outlook Web App, where they can view the message and
send replies.

d o« Encrypted Message x ar

< & 23 outlook.office365.com/Encryption/default.aspx

| Sian Out || [ "Help

Test Email to Gmail

@ ’ - @rsccd.edu>  © Replyall | v
Today, 2:08 PM

@gmail.com> ¥

Encrypt: This message is encrypted. Recipients can't remove encryption.

Test Email to Gmail

7 o Encrypted Message X ar
< c 25 outlook.office365.com/Encryption/default.aspx

Sian Out || [ "Help

= Send [ Attach  Discard  see

Encrypt: This message is encrypted. Recipients can't remove encryption.

To @ @rsccd.edu> X Bce

Cc @ N.F. X

Re: Test Email to Gmail a

Reply to test email
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Remove or change the encryption type from sent emails
(Outlook desktop app only)

If you have already sent an email with encryption, you can remove the encryption
after it has been sent, or change the encryption type.

NOTE: Only the original sender of the email has permission to alter an email’s
encryption options.

NOTE: The steps below to remove encryption can only be done from Outlook
desktop app.

Step 1 — Go to your Sent Items in Outlook

Open Outlook and open the Sent Items folder.

v @rsccd.edu

> Inbox 4
Drafts [2450]
Sent ltems

> Deleted Items

Archive

Step 2 — Find and open the encrypted mail you sent

Find and open the encrypted email you sent (double click to open it).

Fish Tank

Test Email to Gmail

This message Is protected with Microsoft




Step 3 — Select File > Encrypt > Unrestricted Access

1. In the email, go select File.

ol H ™ I ¥ TestEmai. je,

File [ Message Help Acrobat

Test Email to Gmail
S
To Fish Tank

Encrypt-Only - This message is encrypted. Recipients can't remove encryption.
Permission granted by: @rsccd.edu

2. Under Info, select Encrypt. From the Encrypt menu, select one of the
following options:
A. Unrestricted access. This removes any encryption on the email.
B. Encrypt-Only: This message is encrypted. Recipients cannot remove
encryption.
C. Do Not Forward: Recipients cannot forward, print, or copy content.

Test Email to Gmail - Message (HTML)

Test Email to Gmail

Info o~ Encrypt this item

This message is encrypted. Recipients can't remove encryption.

Save Encrypt

~

Save As

Unrestricted Access

B save as Adobe
PDF B v Enaypt-only

Do Mot Forward

Save Attachments




3. Onceyou select a new encryption type, the selected option will reflect next
to the Encrypt menu.

Test Email to Gmail

Encrypt this item

Set up restrictions for this item. For example, you may be able to restrict
recipients from forwarding the email message to other people.

For example, the description text for Unrestricted Access reads: “Set up

encryption for this item. For example, you may be able to restrict recipients from
forward the email message to other people.”




Troubleshooting problems

Contact the ITS Help Desk

e Website: https://rsccd.edu/helpdesk
e Phone: 714-564-4357 Extension 0
e Email: helpdesk@rsccd.edu

(Select this link to return to the beginning of the document)



https://rsccd.edu/helpdesk
mailto:helpdesk@rsccd.edu
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